Adobe Illustrator Tips, Tricks and Tweets
On January 28th, I spend the day, from 4am to 10pm
on Twitter sharing tips, tricks & tweets using Illustrator.
You will in this PDF an archived copy of all my tweets
done during that day. Share the Illustrator love! Enjoy!
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20:39:35 Tomorrow is the Adobe Illustrator Tips, Tricks & Tweets day... #AITTT
20:43:51 @kajorn Than, good morning Kajorn! If you have a Illustrator tips to share send it with the
#AITTT tag.
20:59:32 @kajorn Wonderful! Thanks

Thursday, 28th of January.
04:10:53 @lizign Hi Liz, nice new picture avatar!
04:39:32 @TipSquirrel Good morning!
04:40:51 Hey, Tweeples it’s only 4:30am for me but let start this Adobe #Illustrator Tips, Tricks & Tweets
day now #AITTT
04:42:11 If you have a questions about #illustrator send it to me @jctremblay I’ll do my best to answers
you. #AITTT
04:43:53 @TipSquirrel LOL... it’s early right!
04:45:13 Enabling editable crop marks in Adobe #Illustrator CS4 using the CS3 Crop Marks filter plug-in
[Mac] http://is.gd/7cT8f #AITTT
04:46:09 Enabling editable crop marks in Adobe #Illustrator CS4 using the CS3 Crop Marks filter plug-in
[Win] http://is.gd/7cTij
04:49:54 Get the inside scoop on Adobe Illustrator from the source - members of the Illustrator team Blog
at: http://is.gd/5UI5V #AITTT
04:52:23 Follow @InsideAI - Adobe #Illustrator product development, marketing, and engineering team
on twitter. #AITTT
04:53:51 Creating a see through editable text object in Adobe #Illustrator http://twtfaq.com/1bkfpb #AITTT
04:58:45 Do you know their is a forum for Adobe community of #Illustrator users? Nothing like a fellow to
help you! http://bit.ly/aPnYvV #AITTT
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05:01:10 Illustrator Tips: Press Shift+X to swap fill/stroke color, Press X toggle focus, Press D to return to
default color #AITTT
05:04:00 Check it out! Great Video on #Illustrator on AdobeTV | http://is.gd/7cW7j #AITTT
05:05:48 Opt-click/Alt-click any document profile name on the Welcome screen to bypass the New
Document dialog. #AITTT
05:07:31 Hey, tweeples. It's your day too! Any tips and stuff to share on Illustrator. Do it and add the
#AITTT tag
05:09:03 @adamjury @shoshanak @AshuMittal @TipSquirrel Thanks friends for your RTs... Hope you
learn something yourself!
05:12:14 Appearance Panel magic with Adobe #Illustrator - by @rufusd - http://is.gd/7cXpZ #AITTT
05:14:48 Join the Adobe Illustrator Group (over 45000 members) on Facebook http://www.facebook.com/AdobeIllustrator #AITTT
05:19:10 Take a look in the Cool Extras > Sample Files > Sample Art folder for amazing art along with
PDFs explaining how it was done #AITTT
05:20:56 Hey members of the #AdobeCP join me today for this #Illustrator Tips/Tricks&Tweets day!
#AITTT
05:24:11 Adobe Illustrator Keyboard Shortcut to Scale Objects | GoMediaZine http://is.gd/7cYjd #AITTT
05:29:06 Illustrator: Use Object > Transform > Transform Each menu to transform a group of objects by
their center individually #AITTT
05:38:10 Fan or Escher pattern? Part 1 - Read about it in this PDF from Adobe Mag dated 1999 (Still
good) http://bit.ly/9Q6riH #AITTT
05:40:19 Fan or Escher pattern? Part 2 - Take a look at the Tessela Plugin for #Illustrator
http://bit.ly/bwUQdq [Mac & Win] #AITTT
05:44:19 Illustrator Pattern inspiration? - Look at Drip Dot Swirl: 94 Incredible Patterns book by @Vonster
http://bit.ly/lzfnv #AITTT
05:49:57 Breakfast time and walk my daughter to school. Back in ~2hrs for the day with the Adobe
Illustrator Tips/Tricks & Tweets #AITTT
05:51:19 If you learn/read something good so far go ahead and Retweet it for your own followers. Add
your own tips too. #AITTT
08:18:16 Hi Tweeps! I’m back. Let continue our Adobe #Illustrator Tips/Tricks & Tweets day... #AITTT
08:21:08 If you just woke up, search the #AITTT hashtag to catch up the tweets from this morning. Yes, I
was up at 4:30am!
08:22:06 If you have a questions about #illustrator send it to me @jctremblay I’ll do my best to answers
you. #AITTT
08:23:12 Si vous avez une question sur #Illustrator. Je ferai de mon mieux pour vous répondre. # AITTT
08:24:56 What is that #AITTT ? It’s me, you and Illustrator on twitter for the whole day. Oh, and my cat
"Gilles" ;-)
08:26:34 @GenerationAgile Bonne journée Bruno! Merci pour le clin d’oeil!
08:30:06 @Nescreation Good morning Renee. Do you use Illustrator in any way?
08:33:23 @GenerationAgile Logiciels de dessins vectoriels d’Adobe utilisé depuis 1987 http://en.wikipedia.org/wiki/Adobe_Illustrator
08:35:08 @dltmphoto Thanks! Hope you will learn a lot more. Share with your followers...
08:37:24 Do you know you can get a fully working version of the latest Illustrator for 30 days? free!
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http://www.adobe.com/downloads/ #AITTT
08:40:37 @Nescreation Than you might learn a few thing from me today! ;-) Have a good days with the
boys...
08:42:54 Want to know the differences between the last 4 version of illustrator? See that chart
http://bit.ly/cInP2c #AITTT
08:43:49 @Nescreation I’ll try to find some basics one just for you...
08:48:10 @TGPBall Want to learn on Illustrator. I’m doing a full day of Tips/Tricks & Tweets right now!
08:52:08 Tweeps, let me introduce you to my helper for today Tips, Trick & Tweets #AITTT
http://twitpic.com/105epz
08:56:23 College students can save up to 80% off the full retail price with Adobe Creative Suite.
http://is.gd/7dxTS #AITTT
09:02:20 Zen Of The Pen by Sharon Steuer: Free Illustrator Vector Pen Tool Worksheet Tutorial on
@gcoghill blog http://is.gd/7dz2n #AITTT
09:04:55 Follow @gcoghill Cartooning & Illustration guru - http://georgecoghill.com/blog/ - #AITTT
09:07:04 @artvscraft Hi Fanie! Thanks for the RTs... one of theses days I will need to do a illustrator
tweetup in MTL!
09:08:40 For the #Illustrator Brush lover in you! High Quality Adobe Illustrator Brush Sets
http://is.gd/7dACA #AITTT
09:11:22 @strauchjwju Want to learn on Illustrator. I’m doing a full day of Tips/Tricks & Tweets right now!
09:14:51 Switch from the Illustrator Selection tool to the Direct Selection tool on the fly by holding down
the Cmd/Ctrl key #AITTT
09:15:47 @danallen Thank you buddy.. have a great day!
09:16:48 @artvscraft Cool... on va commencer par un tweetups bientôt. Stay tuned!
09:20:17 The most useful blog on Illustrator is by my friend Mordy, Go check it out. http://bit.ly/ccfO6y
RealWorld Illustrator #AITTT
09:26:03 Mordy is the author of the excellent Real World Illustrator book. http://bit.ly/aHffzi #AITTT
09:26:41 What? Your using Illustrator and your are not following @mordy go ahead and click that *follow*
button now! #AITTT
09:31:23 Illustrator Tips: cycle through ruler units with Cmd-Option-Shift-U [Mac] / Ctrl-Alt-Shift-U [Win]
#AITTT
09:40:19 Read about the release history of Illustrator on Wikipedia
http://en.wikipedia.org/wiki/Adobe_Illustrator #AITTT
09:42:01 First version of Illustrator was release in 1987... Where were you? #AITTT
09:46:44 @poliquinp Bon ben là j’me sens vieux! LOL Bonne Journée Patrice!
09:49:11 For the tweeps that just woke up... Welcome! Follow the #AITTT tag, Illustrator Tips/Tricks &
Tweets all day.
09:51:32 My interview with Sharon Steuer, on the Illustrator WOW book here: http://bit.ly/Sharon #AITTT
09:55:02 Check the Illustrator CS4 WOW Book. Great mix of Tutorials, Gallery and Introduction
http://bit.ly/illustratorWOW #AITTT
09:55:24 RT @mordy: here's an Illustrator tip: hold the Tilde key while moving, scaling, or rotating objects
to modify JUST the pattern fill #AITTT
09:56:15 @mordy Good morning Mordy! I’m having so much fun... ;-)
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10:00:57 Get inspired by following @Vonster - No one can manipulate the vector pen tool like he do!
#AITTT
10:02:02 Visit Von class http://www.illustrationclass.com/ or web site http://www.vonglitschka.com/
#AITTT
10:05:34 For more Illustrator history, see @jmvrankin archaeological dig through the contents of an
Illustrator 88 box. http://bit.ly/aBuYJn #AITTT
10:05:56 @jmvrankin Thanks Mike... have a good day!
10:10:08 @sigurarm Don’t have the original disk... nor any computer that can read floppy!
10:12:00 Original video tutorials that came with Illustrator 88 - Rufus Deuchler | Travelogue- History
lessons http://is.gd/7dNMC #AITTT
10:17:35 Hold down the Option[Mac] / Alt [Win] key when you move or transform with the bounding box
to create a duplicate #AITTT
10:18:48 Hold down the Option[Mac] / Alt [Win] key and use the Arrow Key to duplicate object according
to Units & Increments Pref #AITTT
10:22:12 Three great illustrator Tutorials site: www.vectordiary.com - www.vectips.com www.vectortuts.com - #AITTT
10:24:10 You can follow theses 3 twitter account for the 3 tutorials sites mentioned @Vectips
@VECTORTUTS @vectordiary #AITTT
10:27:24 My first drawing with illustrator was a Cow and I used Illustrator 88 - What about you? #AITTT
10:29:32 @liamarchand Congrat! ... for the thing you did right in Illustrator. The first 400 design are
difficult, after that it's easy. ;-)
10:31:25 @sakisbeekeeper Have a great *last* training lesson
10:37:17 Short break time for me and the cat http://twitpic.com/105epz - Be back soon. Search #AITTT
for everything you have miss so far!
10:38:09 @Vectips Hi Ryan... Thanks! Share yours own tips with the hashtag... peoples will get it.
10:39:56 RT @adamzea: first drawing was an American Flag using Illustrator 4 on Windows 3.1 B&W
screen laptop with I think 8Mb of RAM? #AITTT
10:49:59 I'm back... (oups! we are back) it's the illustrator Tips/Tricks & Tweets day! Yeah! #AITTT
10:50:36 RT @dirtywordstv: Illustrator can be black magic (but real, unlike magic) & @jctremblay is
rocking out a ton of tips for it #AITTT
10:51:55 @adamjury Thanks for the shoot out from @dirtywordstv
10:55:24 Welcome to all the new tweeps! Hope you get a nice day... having a question on Illustrator.
Tweet it to me or see profile for email
10:55:35 The tips/tricks & Tweets day have been going since 4.30am best thing to do is a search with
#AITTT
10:56:37 Salut les fanco qui me suivez.... Désolé de remplir votre feed aujourd’hui. Cela ne durera qu’un
jour! ;-)
10:59:57 @deesadler You know what the cat is sleeping and I’m the only one working here... a real
looser that cat!
11:04:23 If you have some $$ (they will be worth spend!) look at these illustrator videos on
@lyndadotcom http://bit.ly/aWaEng #AITTT
11:09:28 An amazing plugin for Illustrator The PhantasmCS plugins from Astute Graphics - Welcome to
Astute Graphics - http://bit.ly/bRzUAr #AITTT
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11:10:04 Illustrator remembers your last operation - Repeat it by the Transform Again command Cmd-D
[Mac] / Ctrl-D [Win] #AITTT
11:11:07 @DeeSadler Right, I use it when my hand is cold! ;-)
11:14:46 Your Illustrator CS or CS2 fail to launch after applying the Mac OS X Acrobat 8.2 update. Read
this. http://is.gd/7e2eP #AITTT
11:19:20 You can access the Help systems for Illustrator CS4 here: http://bit.ly/dnocM5 - #AITTT
11:20:23 If you have any content (blog, Tips & Tutorials) you can add them to the help system #AITTT
11:22:00 Click the top left corner of the help system to get a complet PDF copy to your HD
http://twitpic.com/1061aw #AITTT
11:25:21 When on the help change en_US to fr_FR to go same page in french - es_ES for spanish de_DE for Deutsch - #AITTT
11:27:05 Got a specific quesion on Illustartor, don't be shy... #AITTT
11:31:41 Your on LinkedIn - Here the link to the Illustrator Group you can join in - http://bit.ly/ahSHxX
#AITTT
11:32:20 @shoshanak Thank you! and for all your retweets too!
11:34:04 Your on Facebook? Link to the Illustrator fans page http://www.facebook.com/AdobeIllustrator - #AITTT
11:35:04 Found a bug or want to suggest a features for future version of Illustrator - Send them here:
www.adobe.com/go/wish #AITTT
11:35:47 @SoniaSanfacon Bonjour Emmanuelle!
11:39:08 You don't like facebook... and prefers NING - Here you go Illustrator Ning Group
http://adobeillustrator.ning.com/ #AITTT
11:42:05 Following the iPad buzz from yesterday... How To Create iPhone Icons with Illustrator CS4!
http://bit.ly/Qn2c5 by @vectorart - #AITTT
11:46:15 Enabling editable crop marks in Adobe #Illustrator CS4 using the CS3 Crop Marks filter plug-in
[Mac] http://is.gd/7cT8f(preview) #AITTT
11:49:33 Enabling editable crop marks in Adobe #Illustrator CS4 using the CS3 Crop Marks filter plug-in
[Mac] http://is.gd/7cT8f #AITTT
11:53:01 Take a look at this bunch of useful illustrator plugins from Rick Johnson - Some free
http://bit.ly/bKgPSk #AITTT
11:56:09 Enabling editable crop marks in Adobe #Illustrator CS4 using the CS3 Crop Marks filter plug-in
[Win] http://bit.ly/9J6oF2 #AITTT
12:01:40 Cycle through open documents with Cmd-~ (tilde key) [Mac] / Ctrl-F6 [Win] #AITTT
12:03:52 Use the space bar to reposition an object has you are drawing it. #AITTT
12:05:51 We are in 2010! So stop saving your document in EPS format when placing them in Indesign #AITTT
12:08:23 Illustrator does not have an auto recovery feature like Indesign so Save & Save often #AITTT
12:14:53 Need an official logo in Vector format - http://www.brandsoftheworld.com/ #AITTT
12:17:54 Lunch time for me... Illustrator Tips/Tricks & Tweets will resume in 30mins. #AITTT
12:18:36 New followers... search for the #AITTT hashtag to see what you have been missing so far!
12:27:18 @Vonster No need to copy/paste just save it as native illustrator .AI document and place in
indesign
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12:41:43 My co-worker for today is just a lazy looser! #AITTT http://twitpic.com/106du1
12:49:46 Ex-Freehand user check this series of video from @mordy Migrating from Freehand to
Illustrator http://bit.ly/damRDd #AITTT
12:52:14 FreeHand to Illustrator Migration Guide [PDF 4.2mg] http://bit.ly/bcdMPx - #AITTT
12:52:57 Technical Guide for FreeHand Migration [PDF 1.0mg] http://bit.ly/a6WJGD #AITTT
12:53:51 Art Files - File Collection for Adobe Illustrator Documents by @codelinesoft http://is.gd/7eoXU
-#AITTT
12:56:13 Tired of forgetting White Overprint attributes in Illustrator document - Check
WhiteOverprintDetector http://bit.ly/cvmiOA #AITTT
12:59:05 New to Illustrator? This will get your started! - 10-Week Course – @creativetechs Classes
http://bit.ly/9x3QeE #AITTT
13:01:50 You are drawing technical stuff don't do it without HotDoor CadTools - http://bit.ly/9B8I4A
#AITTT
13:08:47 the "Create PDF compatible file" when saving an .AI document allow you place it in
Indesign/Photoshop, view in Acrobat #AITTT
13:10:37 the "Create PDF compatible file" make file bigger and longer to save, if you won't place/open in
others apps, turn it off #AITTT
13:15:17 You get the "Create PDF compatible file" when you save as Illustrator doc. #AITTT
http://twitpic.com/106j8v
13:22:13 @DuffJohnson Hi Duff.. Do you have one? or a blog article. My understanding is that AI is pretty
limited
13:27:27 @DuffJohnson I can try to get you an answer. What your question in details. email it to info [at]
proficiografik.com
13:32:17 Copy & Paste Illustartor objects as Smart Object to embed it in the Photoshop & Edit back in AI
by dbl-Click on PS layer #AITTT
13:34:05 Check this video from Layer Magazine - Using Smart Objects with Illustrator and Photoshop
http://bit.ly/cVBLxd - #AITTT
13:35:11 @pdfsage @DuffJohnson Thanks Leonard... That what I was thinking. Duff is that answers your
questions?
13:36:38 Speaking of @LayersMagazine - Check this whole section on Tuts & Videos on Illustrator http://bit.ly/9iaYQI #AITTT
13:38:20 RT @dariodh: Adobe makes great applications. Photoshop is a masterpiece of power. Illustrator
is fantastic. InDesign is very robust.
13:40:01 Illustrator can be so intimidating when you start using it. Set yourself reasonable goal to learn a
new thing everyday! #AITTT
13:41:40 @simonhartmann We all have of prefered in life... ;-)
13:45:20 Creating a see through editable text object in Adobe #Illustrator - http://twtfaq.com/1bkfpb
#AITTT
13:47:02 Explore new features in Adobe Illustrator CS4 with these how-to guides and source files
http://bit.ly/9JDxlk - #AITTT
13:50:08 Find good book , articles & free sample chapters on Illustrator at http://www.peachpit.com/
#AITTT
13:52:01 inside scoop on Adobe Illustrator from the source - Blog
http://blogs.adobe.com/infiniteresolution/ Follow them @InsideAI #AITTT
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13:53:51 Want to Map art into a 3d Effect object. Turn it into a symbol first, than click Map Art Button in 3d
dialog #AITTT
13:59:10 @crych Watch for a bunch of link on graphing in a few minutes.
13:59:59 Coming up on #AITTT a bunch of useful link on how to create cool graphs in Illustrator.
14:01:23 [From CS2, but nothing have changed ] Put the “art” in chart with Illustrator by @mordy
http://bit.ly/aJhPya #AITTT
14:06:04 Illustrator How-To: No More Boring Graphs EVER on CreativePro.com http://is.gd/7eEEe
#AITTT
14:07:09 Bar Graph in Adobe Illustrator | Free Adobe Illustrator Tutorial by @davecross at
@LayersMagazine http://is.gd/7eEJD #AITTT
14:13:03 For an Idea How Adobe Illustrator will Round Trip in upcoming Adobe Flash Catalyst - InsideRIA
http://is.gd/7eFOk #AITTT
14:13:25 @Peachpit Your welcome.... you have been so generous!
14:15:43 Just opened your twitter feed and wondering what's up with me today? It's Tips/Tricks & Tweets
Illustrator day! #AITTT
14:17:36 RT @suzanhill: loving illustrator cs4 - Your not alone!
14:19:18 Choose "Add Used Color" in Swatches Menu to let Illustrator create all Swatches from object
apply with the Color Panel #AITTT
14:21:44 The Graphic Mac blog have a section on Illustrator http://bit.ly/9Z6eUg follow them too at
@thegraphicmac #AITTT
14:22:35 @DeniseHampson I think you have learn it now. (at least for today!) Save and Save often...
14:24:09 Check what we have been sharing with you today on twazzup - http://bit.ly/bSDeET - #AITTT
14:26:49 What is and Why use Global Swatches Color - Old blog post but still valid by @mordy http://bit.ly/dw6uRQ #AITTT
14:28:32 Great collections of Plugins for Illustrator by Worker72a - [Mac only] http://is.gd/7eJ0U
14:32:03 Not expensive collection of Symbols, Styles, Brushes and more at
http://www.graphicxtras.com/ Follow them @graphicxtras #AITTT
14:34:18 Illustartor Plugin - Xtream Path - Grab anywhere on a path! http://is.gd/7eKgK
14:35:01 When you need that cool effect! - FILTERiT4.2- Adobe Illustrator plugin http://is.gd/7eKp0
#AITTT
14:39:47 Adobe Illustrator Tips and Resources from Senecadesign [That's you @amarie ]
http://bit.ly/bcPEl8 - #AITTT
14:43:20 Designer's Guide to Transparency [PDF 5.5mg] http://bit.ly/d8zZaX - #AITTT
14:44:09 Transparency in Adobe Application [PDF 5.1mg] http://bit.ly/9O9hmY - #AITTT
14:46:44 Me and Gilles are going in Break... #AITTT - What was your first drawing in Illustrator & Which
version?
14:48:24 @creativetechs Thanks! Been a great day so far. At least I do have some fun ;-)
14:59:14 @squire225 Hey dude! Their is an hashtag on all of the tweets so you can search for #AITTT You won't miss any! Follow me you get more ;-)
15:00:31 @ellejohara How this the multiple artboard fuckup the PFD? I may help
15:02:59 If you hold the Shift key when you click on the fill or stroke icons in the Control panel, you get
the Color panel sliders. #AITTT
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15:08:32 This is a treasures box of links and great info from Teri Pettit (Senior Software Engineer at
Adobe) - http://bit.ly/9W4PmK #AITTT
15:09:47 @ellejohara And the results is different than in Cs3 or prior?
15:15:57 @ellejohara Do you time to join me here - http://tinychat.com/aittt
15:21:44 Cmd/Ctrl click the New Swatch Icon to make it a new Spot color. Add the Shift key when you
click to create a new Global color. #AITTT
15:22:37 @amarie But now they know where to find them and you! ;-)
15:37:55 Illustartor 3d effects can produce cool stuff. Learn from this collection of tutorials http://bit.ly/dh46RC #AITTT
15:42:24 If you have to learn one thing in Illustrator, learn to use the Appearance & the Graphic Style
Panel http://bit.ly/9nFHR2 #AITTT
15:43:15 What!? Not yet on Illustrator CS4 - Read what you are missing from Mordy review on
CreativePro - http://bit.ly/cUrnuL #AITTT
15:46:56 Do you know their is a Illustrator User group on the San Francisco Bay area?
http://bit.ly/amtRs1 #AITTT
15:49:03 Their is also one user group in Los Angeles http://bit.ly/dxwj4Y Managed by @Chanam #AITTT
15:50:41 RT @shesLBoogie: Adobe Illustrator is the best thing ever invented. [Maybe after the peanuts
butter & toilet paper]
15:51:49 Hey why not start your own illustartor user group? http://groups.adobe.com/pages/home #AITTT
15:54:02 Anyone following me in Montreal - Let's talk and start a local Illustrator meeting soon. #AITTT
15:56:20 Download the free Pantone Goe™ libraries for creative suite at
http://www.pantone.com/goefree [Free registartion required] #AITTT
15:59:32 in CS4 Option/Alt click the top row of Pathfinder panel button to create Compound Shape (was
default behavior CS3 and below) #AITTT
16:01:14 Tweeps! It's 4pm - Break/Dinner will be back in ~ 7:30pm for a last 2hrs of Tips/Trick & Tweets.
#AITTT
16:02:57 Dear followers... old & new! If you enjoy any of the tweets so far, don't hesitate to share it and
Reweet them. Thanks!
16:04:04 RT @selfproclaim: I still love learning new Illustrator techniques after all these years [ It's a
never ending love story! ]
16:09:42 Est-ce que cela existe un outils pour compter le nombres de tweets avec un hashtag specific?
16:10:18 I'm exhausted... but happy! You?
16:43:49 @gcoghill No way to convert really but Select the text, copy or cut than click paste (point text) or
click drag (text area)
16:59:14 @gcoghill You want the path back! Have you try direct selecting the path. I think you will be able
to color it
17:15:06 @gcoghill You can copy the path by option+Direct Select it, than copy/paste ....
17:15:51 @DuffJohnson Your welcome... Leonard was the guys to ask the question.
17:20:19 @gcoghill I was outside and did not check the feed when I was back to see you have figured it
out. Sorry!
18:23:44 @philgauthier Beaucoup de gueule ton site. Bravo!
18:27:26 Useful Illustrator CS4 resources in PDF by JetSeTCom http://bit.ly/atsDwl [ Thanks
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@Mike_Witherell ] #AITTT
18:31:20 Want to feel the Power of the Appearance Panel in Adobe Illustrator! Check the video at Rufus's
blog http://bit.ly/cQRfxt #AITTT
18:38:47 Use the Option-drag [mac] /Alt-drag [win] with the Eraser Tool create marquee to erase a
rectangular area #AITTT
18:41:22 @Peachpit Congrats! Wonderful @theindesigner book is one of the four.
18:43:50 Illustrator: Option-click [Mac] / Alt-click [WIn] the Trace button to convert raster and expend it to
a set of paths. #AITTT
19:11:30 Hi Tweeps... ready for a last bunch of illustrator Tips Tweets? #AITTT
19:12:22 Interesting Scripts for automating Adobe Illustrator at Kelso Cartography http://bit.ly/c0PAx3
Thanks @kelsosCorner #AITTT
19:13:48 Startup Profiles - A Great tool to Customize your New Documents - Adobe Illustrator
http://bit.ly/aaVBNv #AITTT
19:15:43 Portrait of Yukio Miyamoto | Master of Adobe Illustrator Gradient Mesh Tool http://is.gd/7fFJa
#AITTT
19:23:19 All the illustrator tutorials on GoMediaZine http://bit.ly/cWSf0An #AITTT
19:30:28 Everything you want to know about Live Trace in Illustrator - Creating Vector Content [PDF
1.5mg] http://bit.ly/cGwyHD #AITTT
19:37:05 Bert Monroy's tutorial on Adobe Illustrator's Gradient Mesh tool - http://bit.ly/cGKnjV #AITTT
19:45:47 *Free* EZContrain Illustrator Plugin by Nineblock Software. http://is.gd/7fLay #AITTT
19:47:18 Also check out BetterHandles & SnapMeasure at Nineblock Software - http://is.gd/7fLoJ #AITTT
19:48:33 @kyubikitsy Do a search on Twitter with the #AITTT Hashtag. Lot of stuff to learn Illustrator
today.
19:50:51 Stephen Vincent's Illustrator plug-ins [ My Fav is Tessella! ] - http://is.gd/7fM4w #AITTT
19:54:00 A Must read: How-To: Illustrator Live Paint Is a Bucket of Fun | CreativePro.com
http://is.gd/7fMJb #AITTT
20:04:21 Trés pertinant! - RT @FraserPierre: Êtes-vous multitâche ? Si oui, attention ! « Théorie des
#Tendances http://ow.ly/11AOn
20:21:22 Hi new followers, I’ve been doing the Tips/Tricks & Tweets since the last 16 hours... search for
#AITTT to find what you have miss.
20:27:59 Convert Illustrator Point/Path Text to Area Text | Ajar Productions http://is.gd/7fTie #AITTT
20:28:32 Announcing Merge Text Extension for Adobe Illustrator | Ajar Productions http://is.gd/7fToc
#AITTT
20:29:12 @rlux Hope the MBP is not your main working computer.!
20:32:47 RT @leebrimelow: The iPad provides the ultimate browsing experience?
http://theflashblog.com/?p=1703 #ipad
20:38:57 Want to edit a Brush, drag it to artboard, modify and Option/Alt drag it back on top of thumbnail
in Brushes Panel to replace old one #AITTT
20:41:25 Illustrator Layer set to "Template" are always locked and will never print. Their name appears in
Italic in layer panel. #AITTT
20:44:05 Illustrator CS4 support multiple artboard export to theses raster format TIF, JPG, PSD, or PNG
file. #AITTT
20:52:20 @BlackEyeDesign Still need the PPD?
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20:53:51 @BlackEyeDesign Check your email for the ppd
21:10:53 Cool easter egg in Illustrator - Introduced in the app by Teri Pettit - http://twtfaq.com/kp62ix
#AITTT
21:11:50 You're old when the picture on your mouse pad is the illustrator Venus by Botticelli! #AITTT
http://twitpic.com/108q2n
21:19:30 RT @kajorn: Fix tone mark position for Thai Fonts in Illustrator&Photoshop download Template
for start typing http://bit.ly/9HOksZ #AITTT
21:21:07 @dltmphoto Your welcome! Hope you learn something during the day!
21:26:39 @pixelyzed I don't remember it might also be from AI 8 ... Ouch!
21:27:59 RT @trentd_c: I love Illustrator CS4! I love it too. So much that I have just spend 17 hours
tweeting non stop about it. Search #AITTT
21:29:20 @pixelyzed Oh, yeah!
21:33:13 Choose View > Overprint Preview to see how your overprints will look when they print and
provides the best spot color simulations. #AITTT
21:36:24 To prevent type from changing color when you apply a graphic style to it, disable Override
Character Color in the panel menu. #AITTT
21:42:28 You can control the layer visibility of a placed Illustrator doc in Indesign by choosing Object >
Object Layer Options in Indesign #AITTT
21:44:38 9:45 pm here folks... been doing this #AITTT since 4:30 am... So it's time to stop.
21:45:55 I hope you learn something today. Thanks for thoses you contacted me directly with their
questions. It was a pleasure to help. #AITTT
21:47:37 Welcome all the new followers. If you want to stick around go ahead. I tweet about everything
Adobe, Web 2.0 in french & english #AITTT
21:49:34 If you think my business can help your here is my profile on linkedIn http://ca.linkedin.com/in/jctremblay #AITTT
21:52:02 I do training & support for creative people. Adobe Certified Expert in
Illustrator/Indesign/Photoshop & Adobe Community Professional #AITTT
21:52:52 Find more information about me at my web/blog site http://bit.ly/aCF7BW #AITTT
21:53:56 SInce all the tweets had the #AITTT hashtag, you can serach for them if you want to serach for
them. Do it. ReTweets if useful.
21:54:49 @pixelyzed Merci...
21:58:53 That was the "Adobe Illustrator Tips/Tricks & Tweets Day". Comments are welcome! Good night
& happy vector drawing! #AITTT
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